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Table 1 Document Revision History

Date Description

May 21, 2015 The following updates were made to add defect and fixes for software 
issues due to expiration of an Adobe certificate:

• Caution modified to add information about recommended upgrade to 
Release 4.0 for 3.1.0-797 (SP2) in the “Upgrade Paths” section on 
page 30.

• Added footnote to Table 14 on page 31 for recommeneded upgrade to 
Release 4.0, with requirement of installation by Cisco Technical 
Support or field delivery personnel for the service patch alternative.

• Added “CSCuu22735—Flash player unable to load Control Panel due 
to Adobe certificate issue.” section on page 35.

January 13, 2014 Corrected statement of the tested versions of VMware vSphere ESXi with 
Cisco StadiumVision Director Remote from 4.1 and 5.0 to 4.1 and 5.1.
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September 30, 2013 In addition to bug fixes, the following updates were made for Cisco 
StadiumVision Director Release 3.1.0-797 (SP2):

• Added requirement for Mozilla FireFox browser when logged in as 
Content Manager role in the “Browser and Flash Player Support” 
section on page 4.

• Added a link to the “How to Enable a DMP for Touch Screen Support 
task note in the “Touch Screen Devices and Controller Support” 
section on page 11 and “Touch Screen TV Control” section on 
page 26.

• Added the “Cisco StadiumVision Director TUI Updates in Release 
3.1.0-797” section on page 26 to add information about the new menu 
option for configuration of log file retention.

• Updated the supported upgrade paths for Cisco StadiumVision 
Director 3.1.0-797 (SP2) and added caution for mandatory upgrades 
to SP2 for all venues in the “Upgrade Paths” section on page 30.

• Revised the open and resolved defects lists in the “Caveats” section 
on page 35.

June 20, 2013 In addition to bug fixes, the following updates were made for Cisco 
StadiumVision Director Release 3.1.0-787 (SP1) and Cisco 
StadiumVision Director Remote Release 3.1.0-216 (SP1):

• Updated the “Cisco StadiumVision Director Server Support” section 
on page 6 to clarify spare hard drive requirements and add reference 
to the GSS tool.

• Updated the supported headend hardware in the “Cisco 
StadiumVision Headend Support” section on page 7 to identify the 
Cisco 9900 DCM as EOS/EOL and replaced by the Cisco 9902 DCM. 

• Updated the supported upgrade paths in “Cisco StadiumVision 
Director Server Support” section on page 6 and “Upgrade Paths” 
section on page 30.

• Added the following changes for External Content Integration:

– “Daktronics Scoreboard Integration” section on page 20.

– “Data Throttling Default Values and Registry Configuration” 
section on page 20.

• Added information about the introduction of language support in the 
“Service Packs for Localization” section on page 23.

• Added information about changes to the Cisco StadiumVision 
Director Remote TUI in the “Cisco StadiumVision Director Remote 
TUI Updates in Release 3.1.0-216” section on page 26.

• Revised the open and resolved defects lists in the “Caveats” section 
on page 35.
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Contents 
This release note includes the following topics:

• Introduction, page 4

• System Requirements for Cisco StadiumVision Director Release 3.1, page 4

• New and Changed Information in Cisco StadiumVision Director Release 3.1, page 12

• Installation Notes, page 28

• Limitations and Restrictions, page 33

April 10, 2013 Added information about obtaining full ISO and OVA files to the 
“Software Download” section on page 32.

The following updates were made to the “Upgrade Paths” section on 
page 30:

• Added support for Cisco StadiumVision Director Release 3.0.0-433 
(SP2). 

• Removed Release 3.0.0-429 (SP1) as a supported upgrade path to 
Release 3.1.

March 27, 2013 The following updates were made:

• Added the “CSCuf71129—Management Dashboard GetStatus 
reports inaccurate RS-232 status.” to the open defects list.

• Added reference to the CIMC guidelines for the Platform 3 server.

March 21, 2013 Updated the playlist limitations in the “Limitations and Restrictions” 
section on page 33.

March 19, 2013 For Cisco StadiumVision Director Release 3.1.0-632 and Cisco 
StadiumVision Director Remote Release 3.1.0-205, the following updates 
were made:

• Requirements for the Cisco StadiumVision Director Remote server 
was added in the “Cisco StadiumVision Director Remote Server 
Support” section on page 7.

• Added the “Installation Requirements on New Platform 3 Servers” 
section on page 28.

• The “OVA Files” section on page 32 was added.

• Open and resolved defects were added for the updated software 
release.

• Added defect “CSCuf39019—In Content screen replacing multiple 
files at once might sometimes fail.” section on page 48 to the open 
defects for the initial Cisco StadiumVision Director Release 
3.1.0-510. This defect is resolved in Release 3.1.0-632.

February 28, 2013 Initial release of Cisco StadiumVision Director Release 3.1.0-510 and 
Cisco StadiumVision Director Remote Release 3.1.0-193.
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  Introduction
• Caveats, page 35

• Related Documentation, page 53

• Obtaining Documentation and Submitting a Service Request, page 53

Introduction
This document provides information about the Cisco StadiumVision solution for all releases of Cisco 
StadiumVision Director Release 3.1. It includes hardware and software requirements, new and changed 
features, installation and upgrade information, known issues, and defects.

This document is for Cisco StadiumVision system administrators and technical field engineers who are 
responsible for designing and deploying the Cisco StadiumVision solution. Readers of this document 
should be familiar with basic IP networking technology and the Cisco StadiumVision solution.

System Requirements for Cisco StadiumVision Director 
Release 3.1

This section describes the hardware and software supported by the Cisco StadiumVision solution for 
Cisco StadiumVision Director Release 3.1. It includes the following topics:

• Browser and Flash Player Support, page 4

• Cisco Digital Media Player Support, page 5

• Cisco StadiumVision Director Server Support, page 6

• Cisco StadiumVision Headend Support, page 7

• Cisco Unified Communications Support, page 10

• Commerce Integration Systems Support, page 10

• Media Controller Systems Support, page 11

• Touch Screen Devices and Controller Support, page 11

• Unsupported Hardware and Software in Cisco StadiumVision Director Release 3.1, page 12

Browser and Flash Player Support

You can use an Apple Mac or Microsoft Windows PC or laptop to access Cisco StadiumVision Director 
Release 3.1. 

Table 2 describes the browser software versions that have been tested with Cisco StadiumVision 
Director Release 3.1, with the corresponding Flash player support.

Note Unless specifically identified as unsupported, other browser versions might work, but their compatibility 
with Cisco StadiumVision Director cannot be assured.
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  System Requirements for Cisco StadiumVision Director Release 3.1
Cisco Digital Media Player Support

The DMP firmware image is not bundled with the Cisco StadiumVision Director software. You must 
download the firmware image separately at the software download center site.

Table 3 describes the Cisco Digital Media Player (DMP) hardware and firmware supported in 
Cisco StadiumVision Director Release 3.1.

DMP Firmware Download Guidelines

Note DMP-4310G Version 5.4 supports MP4 (H.264 coded only) video files and adds support for ELO 
IntelliTouch+ technology. Be sure to use this DMP software version if you need to use these features.

DMP-4310G Version 5.4

DMP-4310G Version 5.4 firmware is not available from the Cisco Digital Media Players software 
download site. To download the DMP-4310G firmware, go to the Cisco StadiumVision Director software 
download site at:

http://software.cisco.com/download/release.html?mdfid=283489263&flowid=31962&softwareid=2838
66237&release=3.1.0&relind=AVAILABLE&rellifecycle=&reltype=latest

DMP-4310G Version 5.3.4

To download the DMP-4310G Version 5.3.4 firmware, go to the Cisco Digital Media Players product 
page, click the Download Software link, and navigate to the Cisco Digital Media Player 4310G:

http://www.cisco.com/en/US/products/ps7220/tsd_products_support_series_home.html

Table 2 Tested Browser Software

PC or Laptop OS Browser Version1

1. No additional browser software is tested other than what is listed in this table (for example, not Apple Safari). However, other 
browser software might work.

Flash Player

Apple Mac OS X • Google Chrome Version 24.0

• Mozilla FireFox Version 18.0.12

2. Use the Mozilla FireFox browser when logged in as Content Manager, or log in with the Administrator role if you need to use 
other supported browsers. See “CSCuj07468 —”Content Manager” role unable to upload content using Google Chrome and 
Microsoft IE.” section on page 37.

Adobe Flash Player 
Version 11.5.502.146

Microsoft Windows 
(Windows 7)

• Google Chrome Version 24.0

• Microsoft Internet Explorer Version 9

• Mozilla FireFox Version 18.0.12

Adobe Flash Player 
Version 11.5.502.146

Table 3 Supported Cisco DMP Hardware and Firmware

Hardware Firmware Version

Cisco DMP 4310G DMP-4310G Version 5.4

DMP-4310G Version 5.3.4
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  System Requirements for Cisco StadiumVision Director Release 3.1
Version 5.3.4 is not the latest available version shown on the download site. Be sure to navigate to All 
Releases > 5 > 5.3.4 to display the supported firmware download for Cisco StadiumVision Director 
Release 3.1. 

Upgrade Procedure

For information about how to upgrade the DMP firmware, see the “Upgrading the DMP Firmware” 
module of the Cisco StadiumVision Director Software Installation and Upgrade Guide, Release 3.1.

Cisco StadiumVision Director Server Support

Table 4 describes the Cisco StadiumVision Director server hardware and software supported in 
Cisco StadiumVision Director Release 3.1.

Note Use the Guided Solution Selling (GSS) tool when placing Cisco StadiumVision orders to ensure proper 
configuration and Bill of Materials (BOM).

https://www-gsc.cisco.com/swc/cisco/ciscoAdvisor.action?sfId=CISCO

Table 4 Supported Cisco StadiumVision Director Server Hardware and Software

Hardware Product ID Minimum Software Version Supported
Minimum Tested 
CIMC/BIOS Firmware Spare Hard Drives

SV-DIR-DIRECTOR-K9 Cisco StadiumVision Director Release 3.1.0-797

Minimum upgrade path: 
3.1.0-787 (SP1)

Note For details about all supported upgrade 
paths, see the “Upgrade Paths” section on 
page 30.

Cisco UCS Server 
Firmware versions:

• BIOS—1.4.6a.0

• CIMC—1.4(6d)

Not required

SV-PLATFORM3=1

1. No software image is preinstalled when you order a SV-PLATFORM3= spare server.

Cisco StadiumVision Director Release 3.1.0-797

Minimum upgrade path: 
3.1.0-787 (SP1)

Note For details about all supported upgrade 
paths, see the “Upgrade Paths” section on 
page 30.

Cisco UCS Server 
Firmware versions:

• BIOS—1.4.6a.0

• CIMC—1.4(6d)

Required—
4 additional drives

(SV-HD-A03-D300
GA2=)

SV-DIRECTOR-K9 or 
SV-PLATFORM2=

Cisco StadiumVision Director Release 3.1.0-797

Minimum upgrade path: 
3.1.0-787

For details about all supported upgrade paths, see 
the “Upgrade Paths” section on page 30.

Cisco UCS Server 
Firmware version 1.4(2) 

Required2

2. Two additional 300 GB hard drives for a total of 4 drives are required only for the Platform 2 server in Cisco StadiumVision Director Release 3.1. If you 
need additional drives, contact your Cisco Systems sales representative for more information. For important information about installing additional hard 
drives as part of the upgrade to Release 3.1, see the Cisco StadiumVision Director Software Installation and Upgrade Guide, Release 3.1.
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  System Requirements for Cisco StadiumVision Director Release 3.1
Note For more information about verifying and upgrading the Cisco UCS Server firmware, see the following: 

—On the Platform 2 server, see the “CIMC and BIOS Firmware Installation for Cisco StadiumVision 
Director Platform 2 Servers” section on page 29.

—On the Platform 3 server, see the “Appendix D: CIMC Configuration and Firmware Upgrade 
Guidelines on the Cisco UCS C220 Server” module in the Cisco StadiumVision Director Software 
Installation and Upgrade Guide, Release 3.1.

Cisco StadiumVision Director Remote Server Support

You can use your own server or install a Cisco UCS C22 server to run the Cisco StadiumVision Director 
Remote software. Be sure that your configuration meets the miminum system requirements in Table 5 
and supports a VMware ESXi virtualized environment with a compatible ESXi version (See “VMware 
vSphere ESXi Tested Versions” section on page 7.) 

Note Cisco StadiumVision Director Remote servers are meant to be physically located close to the DMPs that 
they operate with, such as at the remote venue edge, and communicating to the players over a LAN. For 
information about installation-related licensing compliance, see the “Installation Requirements for 
Licensing Compliance” section on page 28.

VMware vSphere ESXi Tested Versions

Cisco StadiumVision Director Remote has been tested with VMware vSphere ESXi version 4.1 and 5.1. 
Other VMware vSphere ESXi versions cannot be guaranteed to work with Cisco StadiumVision Director 
Release 3.1.

For more information about installing Cisco StadiumVision Director Remote servers, see the Cisco 
StadiumVision Director Remote Installation and Upgrade Guide, Release 3.1.

Cisco StadiumVision Headend Support

Table 6 describes the Cisco StadiumVision headend hardware and software supported in 
Cisco StadiumVision Director Release 3.1.

Table 5 Minimum System Requirements for the Cisco StadiumVision Director Remote Server

System Component Minimum Requirement 

Hard Drive Capacity 300 GB

Note The hard drives must be configured as a single logical volume. A 
RAID volume is strongly recommended. 

Processor Single processor equivalent to an Intel Xeon Processor E5-2420 (15 MB 
cache, 1.90 GHz clock, 7.20 GT/s Intel® QPI)

Virtual RAM (VRAM) 16 GB
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  System Requirements for Cisco StadiumVision Director Release 3.1
Table 6 Supported Cisco StadiumVision Headend Hardware and Software

Hardware Device Software Version

Cisco Catalyst 3750 E-series IP Services image 12.2.x or above.

Note Release 12.2(55)SE1 and 12.2(55)SE2 should 
be avoided if using PoE to power DMPs with 
serial numbers USI1434xxxx or below.

Cisco Catalyst 3560 E-Series IP Services image 12.2.x or above.

Note Release 12.2(55)SE1 and 12.2(55)SE2 should 
be avoided if using PoE to power DMPs with 
serial numbers USI1434xxxx or below.

Cisco Catalyst 6500 Series IP Services image 12.2.x or above.

Cisco Nexus 7000 Series Cisco NX-OS Release 4.1 or above.

Cisco Atlas MKII Digital Terrestrial 
Receiver1

Note This hardware device is replaced by the 
Cisco 9887B DVB-T Digital Terrestrial 
Receiver.

DVEO TLV 400 DVB-T2 Digital Terrestrial 
Receiver

The release that ships with the device is recommended.

Cisco D9022 Encoder2 V02.11.10 

Cisco D9034 Encoder3 V03.03.22 

Cisco D9050 Encoder4 V4.00.04 

Cisco D9094 HD Encoder V04L101 

Cisco D9858 Advanced Receiver Transcoder R03.02.00 or later

Cisco D9887B HDTV Modular Receiver 6.3.2 and later

Note This device is replaced by the Cisco 8-VSB 
4-Port or 8-Port ATSC Off-Air Reception DCM 
Module.

Cisco DCM Series D9900 Digital Content 
Manager (DCM) MK II 2RU Chassis5

8.01.86 and later

Note Releases after 8.01.86 require16GB Flash.

Note This device is replaced by the Cisco D9902 
DCM.

Cisco DCM Series D9902 Digital Content 
Manager

• 1 Gb Flash—8.1.86 

• 16 Gb Flash—8.7.0

Note DCMs with only 1G flash do not support 
releases past 8.1.86.and will need a flash card 
upgrade to 16G to upgrade past DCM release 
8.1.86.

Note DRD DVB-S2 cards require DCM 9.1.x and 
later.

Cisco 8-VSB 4-Port or 8-Port ATSC Off-Air 
Reception DCM Module6

DCM Release 8.01.86 (minimum version)

Note DCM Release 8.07.00 is recommended but 
requires 16 GB Flash.
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  System Requirements for Cisco StadiumVision Director Release 3.1
Cisco Dense Receiver and Decrypter 
(DRD)-S2 2-Port or 4-Port DCM Module 
(DVB-S2 Satellite Receiver)7

DCM Release V9.10.00

Cisco Spectra QAM Demodulator8 Note This device is replaced by the DVEO TLV 400 
DVB-C Digital QAM Receiver.

DVEO TLV 400 DVB-C Digital QAM 
Receiver

The release that ships with the device is recommended.

DVEO OnRamp Analog Terrestrial 
Receiver—MPEG-2 output

The release that ships with the device is recommended.

DVEO GearBox Analog Terrestrial 
Receiver—MPEG-4 output

The release that ships with the device is recommended.

Scientific Atlanta Titan S2 DVB-S2 Digital 
Satellite Receiver9

Software Version V02.01.03

Hardware Version F02 Bootloader Version 
V03.01.42528 

Note This device is replaced by the Cisco DRD-S2 
2-Port or 4-Port DCM Module (DVB-S2 
Satellite Receiver).

Technicolor COM100 with COM24 cards ST02.00.3 or later (to support 3D or sonic Tap) 

Technicolor COM200 with COM24 cards ST02.00.3 or later

1. The Cisco Atlas MKII Digital Terrestrial Receiver has reached EOS/EOL.

2. The Cisco D9022 Encoder has reached EOS/EOL.

3. The Cisco D9034 Encoder has reached EOS/EOL.

4. The Cisco D9050 Encoder has reached EOS/EOL.

5. The Cisco DCM Series D9900 Digital Content Manager (DCM) MK II 2RU Chassis has reached EOS/EOL.

6. The Cisco DCM 8-VSB ATSC Off-Air Reception Module is the replacement for the Cisco D9887 HDTV Modular Receiver 
for US ATSC implementations only.

7. The Cisco DCM DRD DVB-S2 Module is the replacement for the Cisco Titan DVB-S2 Digital Receiver and Cisco Indus MK 
II Transport Stream Descrambler.

8. The Cisco Spectra QAM Demodulator has reached EOS/EOL.

9. The Scientific Atlanta Titan S2 DVB-S2 Digital Satellite Receiver has reached EOS/EOL.

Table 6 Supported Cisco StadiumVision Headend Hardware and Software (continued)

Hardware Device Software Version
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  System Requirements for Cisco StadiumVision Director Release 3.1
Cisco Unified Communications Support

The Cisco StadiumVision solution supports the Cisco Unified IP Phone 7975G and 9971 models.

Cisco Unified IP Phone 7975G

Table 7 lists the combinations of Cisco Unified Communications Manager (CUCM) and firmware for the 
Cisco Unified IP Phone 7975G that were tested for compatibility with Cisco StadiumVision Director 
Release 3.1.

Cisco Unified IP Phone 9971

Table 8 lists the combinations of Cisco Unified Communications Manager (CUCM) and firmware for the 
Cisco Unified IP Phone 9971 that were tested for compatibility with Cisco StadiumVision Director 
Release 3.1.

Note Although not all combinations have been tested, earlier maintenance versions of CUCM are also likely 
to work with Cisco StadiumVision Director Release 3.1. Avoid trying to use any major version other than 
8.6 and 9.0. For example, any other major version such as 5.1 or 8.0 is not supported. CUCM 8.6 is 
required for IP phone localization support.

Commerce Integration Systems Support

Table 9 provides information about the hardware and software for third-party commerce integration 
systems that have been tested with Cisco StadiumVision Director Release 3.1. 

Table 7 Tested Cisco Unified Communications Compatibility for the IP Phone 7975G

IP Phone Model CUCM Version Cisco Unified IP Phone Firmware

Cisco Unified IP Phone 7975G 8.6(2), 8.6(2a)1

1. CUCM 8.6 is required for localization of the speed dial interface on the Cisco Unified IP Phone. 

9.3(1) SR1

9.0(1) 9.3(1) SR1

Table 8 Tested Cisco Unified Communications Compatibility for the IP Phone 9971

IP Phone Model CUCM Version Cisco Unified IP Phone Firmware

Cisco Unified IP Phone 9971 8.6(2), 8.6(2a)1

1. CUCM 8.6 is required for localization of the speed dial interface on the Cisco Unified IP Phone. 

9.3(2)

9.0(1) 9.3(2)

Table 9 Tested Commerce Integration Systems Compatibility

Hardware Device1 Software Version

Micros 9700 Enterprise Management Console 3.60.380

Micros 9700 Suites Management Application 1.0

Micros 9700 ContentManager 1.01
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  System Requirements for Cisco StadiumVision Director Release 3.1
Media Controller Systems Support

Table 10 provides information about the hardware and software for third-party media controller systems 
that have been tested to support the External Event Trigger feature in Cisco StadiumVision Director 
Release 3.1. 

Note To support the Crestron Room Media Controller with Cisco StadiumVision Director it requires that you 
work with a Crestron reseller to install the appropriate software on the QM-RMC.

Touch Screen Devices and Controller Support

Table 11 provides information about the hardware and software for third-party touch screen controller 
systems that have been tested in Cisco StadiumVision Director Release 3.1 for ELO-type controllers. 
See the “User TV Control” section on page 27 and the “How to Enable a DMP for Touch Screen Control” 
task note for more information about how to configure this support.

Note For more information about touch screen drivers supported by the Cisco DMP 4310G, see the “Generally 
Supported Touchscreen Driver Categories” and “Supported Touchscreen Drivers in Cisco DMS 5.4” 
section of the Specifications, Supported Features, and Compatibility Information for Cisco Digital 
Media Suite.

Quest Venue Manager 1.5.157 Build 2

Quest Suite Catering Module 1.5.157 Build 2

1. For supported hardware configuration, contact Micros or Quest.

Table 9 Tested Commerce Integration Systems Compatibility (continued)

Hardware Device1 Software Version

Table 10 Tested Media Controller Systems Compatibility

Hardware Device
Minimum 
Firmware Version Custom Software Module1

1. Available to certified Crestron integrators through Crestron.

Crestron Room Media Controller 
(QM-RMC)

4.001.1012 Cisco_StadiumVision_Alert_Trigger-v2.spz

Table 11 Tested Touchscreen Controller Compatibility

Hardware Device

AccuView Model PT220RUE-NT-ZS

ELO TouchSystems 1529L
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  New and Changed Information in Cisco StadiumVision Director Release 3.1
Unsupported Hardware and Software in Cisco StadiumVision Director Release 3.1

This section describes the hardware products and software features that are not supported in 
Cisco StadiumVision Director Release 3.1. 

• Unsupported Hardware Products, page 12

• Unsupported Software Features, page 12

Unsupported Hardware Products

The following hardware products are not supported in Cisco StadiumVision Director Release 3.1:

Note For more information about the replacement products, see the “System Requirements for Cisco 
StadiumVision Director Release 3.1” section on page 4.

• Adtec DPI-1200 Ad Server 

• Adtec TBGS 

• Cisco ADE 2140 Series Appliance (CADE-2140-K9)

• Cisco DMP 4305G

Unsupported Software Features

The following software features and integration are not supported in Cisco StadiumVision Director 
Release 3.1:

• Ad Insertion Manager (AIM)

• CUCM 6.x 

• Video Distribution Manager (VDM)

New and Changed Information in Cisco StadiumVision Director 
Release 3.1

This section describes new features, enhancements and changes in support or behavior in Cisco 
StadiumVision Director Release 3.1. It includes the following sections:

• APIs, page 13

• Centralized Cisco StadiumVision Director Network Architecture, page 16

• DMP Content Expiration, page 19

• External Content Integration, page 19

• External Triggers, page 22

• Internationalization and Localization, page 22

• Mixed Media Playlists, page 24

• Proof of Play, page 24

• Server Administration, page 24

• Touch Screen TV Control, page 26
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  New and Changed Information in Cisco StadiumVision Director Release 3.1
• User Interface, page 27

• User TV Control, page 27

APIs
This section summarizes the Application Programming Interfaces (APIs) that are supported in Cisco 
StadiumVision Director Release 3.1. Any enhancements in Release 3.1 are identified.

• Event Trigger API, page 13

• Media Planner Import API, page 13

• User Control API, page 14

Note All APIs in Cisco StadiumVision Director are made available by special agreement. Contact your Cisco 
Systems representative for more information.

Event Trigger API

Cisco StadiumVision Director Release 3.1 supports an HTTP-based Representational State Transfer 
(REST) API that a software or hardware contact closure source can use to trigger one or more actions 
by the Cisco StadiumVision Director software. For more information about support for external input 
triggers, see the “External Triggers” section on page 22.

Note If you want to control external triggers from a software application, you can contact your Cisco Systems 
representative to obtain the Event Trigger API that is made available by special agreement. 
“TriggerSVD” is an example of a third-party demo application for the Event Trigger API on iOS 
(supporting Apple iTouch, iPhone, and iPad products) and is available as a free download from the 
iTunes store.

Media Planner Import API

Cisco StadiumVision Director Release 3.1 supports the Media Planner Import API that is used to import 
external, third-party generated playlists. The API can be used to support automatic updates to an already 
imported playlist that has been placed in a script, or an external playlist can be manually imported.

The Media Planner API supports the following features:

Import Playlist Functionality

• Automatically creates playlist and populates it with existing content.

• Automatically links missing content to playlist after each missing content item is uploaded.

• Updates to playlists tied to a script that have all content items requires no human intervention.

Special User Interface Indications

• Imported playlist are easily identifiable as “external playlist.”

• Indicates playlist with missing content.

• Warn user when trying to assign a missing content playlist to template.
13
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  New and Changed Information in Cisco StadiumVision Director Release 3.1
• Warn user when starting a script with missing content playlist.

Proof of Play Addition

• Works in the same way as a manually created playlist, but with more granularity.

• Automatic insertion of PoP tag for each time slot play.

User Interface Example

The API automatically creates the playlist, which you can easily identify by an icon that tags it as an 
external playlist source (Figure 1). 

Figure 1 External Playlists in Control Panel Content Screen

The playlist is populated with existing content in Cisco StadiumVision Director, and you are alerted to 
any missing content in the playlist by a red box around the external playlist icon on the Content screen. 
The missing content item is identified with a question mark. Once you import any missing content, it is 
automatically linked to the external playlist.

Current proof of play reporting is fully supported for external playlist sources and PoP tags are 
automatically created for specified sponsor IDs. Any missing content is not included in the PoP report.

User Control API

Cisco StadiumVision Director Release 3.1 supports the in-suite API, which allows querying as well as 
sending control information to Cisco StadiumVision Director.

The API supports the following areas:

• Album Control, page 14

• Information Retrieval, page 15

• Security, page 15

• TV Control, page 15

Album Control

The API album control capabilities for SSC include:

• Retrieve all albums available for play on a specific player.

• Retrieve common albums available for play on a one or more players.
14
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• Retrieve all albums available for play on a one or more players.

• Retrieve the album play duration.

• Set the album play duration.

• Control album loading and unloading of content to the player.

• Control play/pause/stop/next/previous actions of the album.

Information Retrieval

The API information capabilities include:

• Query of which suites that can be controlled.

• Query of all players that can be controlled.

• Query of all players with in a suite that can be controlled.

• Query control features that exist within all suites.

• Query control features that exist within a specific suite.

• Query control features that exist for all players.

• Query control features that exist for a specific player.

• Query A/V inputs that exist for all players.

• Query A/V inputs that exist for a specific player.

• Query of closed captioning capabilities of StadiumVision Director.

• Query the channel guide for a specific suite. Release 3.1 also provides information about channel 
favorites. If a channel is marked as a favorite, the favorite order is included.

• Query the status of all players that can be controlled.

• Query the status of a specific player.

• Detailed HTTP POST response messages in XML.

Security

The API security capabilities include:

• Unique permanent PIN for each suite in order to access and control the devices within.

• Temporary PIN for each suite that changes per event script run, can be displayed on TV. The 
temporary PIN is changed every day at 4 a.m. (default) based on the default scheduled task in Cisco 
StadiumVision Director. It also can be changed on demand using the UI. 

• Common master PIN for administrative control.

TV Control

The API TV control capabilities include:

• Power on and off of the TV.

• Channel change to a channel within the guide.

• Channel change up or down from the current channel in the guide.

• Channel favorites and favorite order (new in Release 3.1)

• Volume change to a specific value.
15
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• Volume change up or down from current value.

• Mute the audio with a specific on or off.

• Mute and unmute the audio with a toggle.

• Closed caption on with specific CC setting.

• Closed caption off.

• A/V input change with specific input setting.

• Show and hide of the information banner on the TV.

Centralized Cisco StadiumVision Director Network Architecture
Cisco StadiumVision Director Release 3.1 introduces support for a centralized Cisco StadiumVision 
Director server that can be used to manage and control content for multiple venues using a distributed 
architecture of Cisco StadiumVision Director Remote servers connected to the central site over the Cisco 
Connected Stadium wide-area network (WAN).

Cisco StadiumVision Director Remote Servers are installed at remote sites to provide a way of targeting 
site-specific content to locally-installed DMPs in a distributed Cisco StadiumVision Director network 
environment, where event operation can also be limited to designated venue operators.

Figure 2 shows a central Cisco StadiumVision Director server connected to the headend, with network 
connections over the Cisco Connected Stadium WAN to multiple remote sites to Cisco StadiumVision 
Director Remote servers.

Figure 2 Centralized Cisco StadiumVision Director with Remote Sites

Cisco StadiumVision Director Release 3.1 introduces the following related features to support the 
centralized Cisco StadiumVision network architecture with Cisco StadiumVision Director Remote 
servers:
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• Hierarchical Management, page 17

• WAN Optimization, page 18

• Multicast Optimization, page 18

Hierarchical Management

The centralized Cisco StadiumVision Director architecture implements control of multiple venues using 
Hierarchical Management, which includes the following areas of functionality:

• Introduction of the Venue Operator role that can be used to limit access and control of event 
operation at one or more assigned remote sites.

• Organization of venue operator, location, playlist, and script objects into site-specific groups using 
venue association to manage access and control.

Figure 3 shows the use of Hierarchical Management in Cisco StadiumVision Director, where a central 
site user with administrator role-based access control (RBAC) permissions is located at the central site 
data center where the primary Cisco StadiumVision Director server resides.

Figure 3 Hierarchical Management in Centralized Cisco StadiumVision Director

The administrator can perform all venue-related functions, including assigning venue operators, content 
and scripts into their corresponding venue-specific scopes of control. At the remote venues, the remote 
venue operators can control the scripts associated to their assigned venue scope-of-control.

For more information, see the following modules of the Cisco StadiumVision Director Server 
Administration Guide, Release 3.1:

• For a description of the supported user roles in Cisco StadiumVision Director, see the “User 
Management in Cisco StadiumVision Director” module. 

• For information about configuring remote venues in a centralized Cisco StadiumVision Director 
network architecture, see the “Configuring Cisco StadiumVision Director for Multiple Venue 
Support” module.
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WAN Optimization

In the non-distributed Cisco StadiumVision Director environment, the Cisco StadiumVision Director 
server sends all staged content to every DMP over the local network. This distribution of content is not 
efficient for the smaller and more expensive WAN links in a distributed Cisco StadiumVision Director 
architecture with remote servers.

Figure 4 shows how transmission of data is optimized over the WAN in the distributed environment, 
where the central Cisco StadiumVision Director server sends each content piece directly to the Cisco 
StadiumVision Director Remote server once, rather than sending multiple transmissions of that content 
to each remote DMP. The remote server then sends the content it receives to each of the DMPs that it 
supports on its local network.

Figure 4 Scalable File-Based Content Distribution

WAN optimization has the following benefits:

• Improved performance by having each content piece cross a WAN link one time (per venue with 
Cisco StadiumVision Remote server).

• Reduction in staging time.

• Increased bandwidth availability for other business applications.

• Reduced WAN infrastructure costs.

Multicast Optimization

The Multicast Optimization feature reduces the scope of multicast messages that are part of an event 
script configured for DMPs located in Cisco StadiumVision Director Remote venues. When configured 
properly, multicast optimization allows the Cisco StadiumVision Director Remote server to rebroadcast 
multicast messages associated with scripts for that venue to be seen only by the DMPs associated with 
that remote site.

Multicast optimization is automatically supported for Cisco StadiumVision Director Remote venues and 
is supported when DMP locations are associated to a venue and the script is configured to run only on 
DMPs at that venue.
18
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For more information about configuring remote venues in a centralized Cisco StadiumVision Director 
network architecture, see the “Configuring Cisco StadiumVision Director for Multiple Venue Support” 
module of the Cisco StadiumVision Director Server Administration Guide, Release 3.1.

DMP Content Expiration
In Cisco StadiumVision Director Release 3.1, the system automatically expires content on DMPs that 
has not been referenced (that is, staged in a script) for a period of time. For non-video content, 
unreferenced content is expired after 14 days, and unreferenced video content is expired after 180 days.

In both cases, once the content has been flagged for expiration, it will be removed from the DMP at the 
next staging operation for that device.

The expiration periods are set by default in the following registry keys in the Management Dashboard 
(Table 12):

External Content Integration
Figure 5 shows a high-level overview of the content support in the External Content Integration feature 
in Cisco StadiumVision Director. Cisco StadiumVision Director Release 3.0 introduced integration with 
external data sources for content ingestion and presentation for NFL GSIS statistics, game clock, and 
certain scoreboard devices. Cisco StadiumVision Director Release 3.1 adds support for predefined data 
feeds such as RSS and Atom, as well as support for generic XML data sources.

Figure 5 External Content Integration High-Level Overview 

The enhancements to the External Content Integration feature in Cisco StadiumVision Director Release 
3.1 includes support for the following updates:

• Predefined Atom and RSS data sources.

• Generic XML data sources.

Table 12 Registry Keys for DMP Content Expiration

Registry Key Default Value

staging.contentDaysToKeep 14 (days)

staging.videoContentDaysToKeep 180 (days)
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• Advanced configuration support for Data views that allow you to merge data from multiple feeds 
and use an expression editor to select certain data elements from those feeds to be put into a single 
combined data source for presentation.

• Preview of live data from the Data Integration interface and from the Widgets layout tool.

For more information on External Content Integration, see the Cisco StadiumVision Director External 
Content Integration Guide, Release 3.1.

Daktronics Scoreboard Integration

This section describes changes in Cisco StadiumVision Director Release 3.1.0-787 (SP1) in addition to 
the feature support described in the Cisco StadiumVision Director External Content Integration Guide, 
Release 3.1.

In Cisco StadiumVision Director Release 3.1.0-787 (SP1), support for Daktronics scoreboard integration 
requires the addition of the Lantronix UDS1100-PoE box. This device must be configured to allow 
connectivity to the Cisco StadiumVision Director server. Figure 6 shows an updated high-level overview 
of the supported scoreboard integration with Cisco StadiumVision Director in Release 3.1 SP1.

Note Daktronics scoreboard integration supports hockey and NBA basketball data only.

Figure 6 Scoreboard Integration High-Level Overview in Release 3.1 SP1

Data Throttling Default Values and Registry Configuration

In Cisco StadiumVision Director Release 3.1, certain data throttling values for External Content 
Integration that were configurable within the Cisco StadiumVision Director Release 3.0 user interface 
per data source were changed to be configurable as registry keys in the Management Dashboard that now 
apply globally to all configured data sources. 

Note The default values and units of measure (from seconds to milliseconds) for these registry keys were 
changed in Cisco StadiumVison Director Release 3.1 SP1. However, if you have modified these values 
from the original default values, then the new default values will not be applied. However, be aware that 
the units of measure will be changed to milliseconds so be sure that you manually convert your original 
value from seconds to milliseconds.
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Caution Configuration of data throttling can be required to maintain optimum DMP performance to support 
External Content Integration in Cisco StadiumVision Director. Be sure that if you plan to modify the data 
throttling values, you understand that DMP performance could be severely impacted, and that you make 
changes only when no events are running in the venue and during an adequate maintenance window for 
the system. 

The actual performance impact is dependent on a combination of factors including the registry values 
that are set, the number of data sources, and the amount of content / widgets / datasources visible on the 
DMP display.

Table 13 describes the global registry keys that apply to all data sources configured for External Content 
Integration in Cisco StadiumVision Director Release 3.1.

Table 13 External Content Integration Data Throttling Registry Keys

Registry Key
New Default 
(Release 3.1 SP1)

Old Default
(Release 3.1) Description

databind.minUpdateInterval 500 ms
(.5 seconds)

10 seconds Specifies the amount of time to wait since the last 
update before sending a multicast of new data from the 
External Content Integration service to all DMPs.

Modify this registry key value to tune the display of 
clock values in Cisco StadiumVision Director (when 
they are inaccurate to the second), by lowering the 
default number of milliseconds.

Note This global registry key corresponds to the 
original “Wait to push data to destination” data 
throttling option in Cisco StadiumVision 
Director Release 3.0, but the option can no 
longer be set per data source and applies to all 
configured data sources.

Tip This control is different than the “Incoming 
data filter rate” data throttling option that 
specifies the amount of time to process only 
new data from the data source to the External 
Content Integration service.

databind.maxUpdateInterval 60000 ms 
(60 seconds)

60 seconds Specifies the longest amount of time to wait before 
sending the multicast of any unchanged data to all 
DMPs. 

For data sources that support setting of polling 
intervals, the practical lower limit for this registry key 
corresponds to that polling interval. The interval cannot 
be set lower than 1000 ms.

Note This global registry key corresponds to the 
original “Push data if wait exceeds” data 
throttling option in Cisco StadiumVision 
Director Release 3.0, but the option can no 
longer be set per data source and applies to all 
configured data sources.
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External Triggers
Beginning in Cisco StadiumVision Director Release 3.1, output triggers also can be configured by the 
administrator to send a Hypertext Transfer Protocol (HTTP) request to notify external systems of a script 
event and trigger an action externally. This functionality can be used with the Cisco StadiumVision 
Mobile Streamer to trigger actions on mobile devices, such as for ad insertion.

Figure 7 shows the different methods that can be used as external output triggers from an event script on 
the Cisco StadiumVision Director server. Just as with input triggers, the supported methods include an 
HTTP call (like a software-based, virtual contact closure) with a 3rd party application, or a standard 
contact closure. 

In addition, the Cisco StadiumVision Mobile Streamer can be used with the HTTP call method to initiate 
actions on mobile devices.

Figure 7 Output Trigger Methods From Cisco StadiumVision Director

For more information about configuring external trigger support by Cisco StadiumVision Director 
administrators who are responsible for working with third-party developers and system integrators to 
establish connectivity for external triggers, see the Configuring Cisco StadiumVision Director for 
External Triggers, Release 3.1 guide.

Internationalization and Localization

Note Cisco StadiumVision Director Release 3.1 SP1 supports internationalization and localization for the 
Cisco DMP 4310G only and the Cisco Unified IP Phone 7975G and IP Phone 9971.

Internationalization (i18n)

Internationalization (known as i18n) support refers to the software infrastructure that is designed to 
accommodate multiple language translations (localization) without requiring additional engineering 
changes to that software. 
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The Cisco StadiumVision Director Release 3.1 software supports i18n for the following general areas of 
the solution:

• Control Panel in Cisco StadiumVision Director

• Dynamic Menu Board application

• Management Dashboard in Cisco StadiumVision Director

• IP Phone user interface

• TV user interface

Localization (L10n)

Localization (known as L10n) refers to the implementation of the specific regional language translation 
support within a software interface that has been designed for i18n. 

In Cisco StadiumVision Director Release 3.1.0-510 and Release 3.1.0-632, English is the only supported 
(and default) language for the Cisco StadiumVision solution. 

Caution A Cisco StadiumVision Director system that is using language support from Release 3.0.0-433 (SP2), 
will lose that support if upgraded to Release 3.1.0-632. Support for other language translations are 
introduced as they become available in Service Packs.

Note Certain locales are not supported in Release 3.1, such as right-to-left languages.

Service Packs for Localization

Note When a Service Pack for Cisco StadiumVision Director is installed, all languages within the SP will be 
automatically installed.

Service Pack 1 (Cisco StadiumVision Director Release 3.1.0-787) includes support for the following 
languages (associated locales are in parentheses):

– Deutsch (de_DE)

– English (en_US). This is the default locale in all Cisco StadiumVision Director 3.1 releases.

– Portuguese (pt_BR)

– Simplified Chinese (zh_CN)

– Spanish (es_ES) 

– Swedish (sv_SE)

– Traditional Chinese (zh_TW)

Note The list of languages in Release 3.1 SP1 does not include French (fr_FR), Italian (it_IT), Japanese 
(ja_JP), Korean (ko_KR), Polish (pl_PL), or Russian (ru_RU), which were part of Release 3.0 SP1.
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Translated User Documents

Available versions of translated end-user documents for Cisco StadiumVision Director can be found at:

http://www.cisco.com/en/US/products/ps11274/tsd_products_support_translated_end_user_guides_list
.html

Mixed Media Playlists
Cisco StadiumVision Director Release 3.1 introduces support for a playlist to contain a mixture of video 
and non-video content. The playlist can be placed anywhere a mixed-media region is defined.

To use, the playlist must be configured for the type “Video and Mixed Media.”

Proof of Play
The following fields have been added to the Proof of Play report in Cisco StadiumVision Director 
Release 3.1:

• Airtime in UTC

• Timezone

Server Administration
The following areas of server administration have been changed:

• Bulk Administration Tool, page 24

• Role-Based Access Control, page 25

• TUI, page 25

• Unified CMS, page 26

Bulk Administration Tool

The TSV file in Cisco StadiumVision Director Release 3.1 supports export of the following additional 
fields for entries that are associated to venues:

• Venue Name

• Venue Timezone

• Venue Remote Server IP

• Venue JMX Username—This field is always ignored.

• Venue JMX Password—The JMX password is saved in the venue information only when the system 
is disabled for global credentials. 

For more information about global credentials and JMX password configuration, see the 
“Configuring Cisco StadiumVision Director Remote Servers” module of the Cisco StadiumVision 
Director Server Administration Guide, Release 3.1.
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Role-Based Access Control

Cisco StadiumVision Director Release 3.1 introduces a new user role called “Venue Operator” for use at 
sites that deploy a centralized Cisco StadiumVision Director network architecture with multiple venue 
support as part of the Hierarchical Management functionality.

Venue Operators have script control only, and only for venues authorized by the administrator for that 
user. In the Management Dashboard, venue operators can view and monitor information on the 
Management Dashboard with read-only access to the venues for which permissions are granted.

For more information about the Venue Operator role and multiple venue support in Cisco StadiumVision 
Director, see the “User Management in Cisco StadiumVision Director” and “Configuring Cisco 
StadiumVision Director for Multiple Venue Support” modules in the Cisco StadiumVision Director 
Server Administration Guide, Release 3.1.

TUI

In Cisco StadiumVision Director Release 3.1, the Text Utility Interface (TUI) has been redesigned and 
streamlined into the following Main Menu categories:

• System Settings

• System Accounts

• Services Control

• StadiumVision Server Administration

• Troubleshooting

For more information about the TUI, see the “Cisco StadiumVision Director Text Utility Interface” 
module in the Cisco StadiumVision Director Server Administration Guide, Release 3.1.

Some of the new and revised TUI functions in Release 3.1 include:

• Changes to the date and time configuration on the server, including new options for time zone 
configuration.

• Changes to the configuration of the backup and restore environment between a primary and 
secondary server. 

For more information, see the “Backing Up and Restoring Cisco StadiumVision Director Servers” 
module in the Cisco StadiumVision Director Server Administration Guide, Release 3.1.

• New Failover option to streamline the tasks needed to do a manual failover to a secondary server. 

For more information, see the “Configuring Failover Between Redundant Cisco StadiumVision 
Director Servers” module in the Cisco StadiumVision Director Server Administration Guide, 
Release 3.1.

• New disk monitoring option, with the ability to view file system usage.

• Ability to delete files.
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Cisco StadiumVision Director TUI Updates in Release 3.1.0-797

In Cisco StadiumVision Director Release 3.1.0-797, the Cisco StadiumVision Director TUI was 
modified with the following changes to allow configuration of the log file retention policy for upgraded 
servers:

• The “Backup/restore Retention Policy” sub-menu from the StadiumVision Server Administration 
menu is renamed to “Retention Policy.”

• A new sub-menu named “Log Files” was added to the revised Retention Policy menu, with 
corresponding options to keep files newer than 5, 10, or 15 days.

Cisco StadiumVision Director Remote TUI Updates in Release 3.1.0-216

In Cisco StadiumVision Director Remote 3.1.0-216, the Cisco StadiumVision Director Remote TUI was 
modified to add the “Setup Staging Parameters” sub-menu to the Network Settings sub-menu with the 
following options:

• Days to keep content

• Number of staging threads

• Milliseconds wait for timeout

Unified CMS

In Cisco StadiumVision Director Release 3.1, all content is now stored in a common, unified Content 
Management System (CMS). This includes video content, which prior to Release 3.1 was stored in a 
separate area for VDM. 

Note After you upgrade from Cisco StadiumVision Director Release 3.0.0-433 (SP2) to Release 3.1.0-632, a 
TUI option is available to prepare your content and migrate it to the new CMS. After validating your 
content, the system supports a TUI option and Management Dashboard system task to remove files from 
the server and DMP. For more information, see the Cisco StadiumVision Director Software Installation 
and Upgrade Guide, Release 3.1.

Touch Screen TV Control
Cisco StadiumVision Director Release 3.1 introduces support for touch screen devices for TV control. 
For information about the tested devices for Cisco StadiumVision Director, see the “Touch Screen 
Devices and Controller Support” section on page 11. For information about how to configure touch 
screen support, see the “How to Enable a DMP for Touch Screen Control” task note.

For information about user TV control in Cisco StadiumVision Director Release 3.1, see the “User TV 
Control” section on page 27.
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User Interface
The following general areas of the Cisco StadiumVision Director user interface (UI) have been changed 
in Cisco StadiumVision Director Release 3.1:

• Cisco StadiumVision Director Login page

An “About” link has been added beneath the copyright to provide software licensing information. 
(Copyright information has been removed from the Management Dashboard, Control Panel, System 
State, and ISO uploader areas of the system.)

• Main Menu

Support for the Video Distribution Manager (VDM) has been removed.

• Control Panel > Control—The Staging control has been relocated here. 

• Control Panel > Content—Playlist types have been modified to include mixed media support. 

The following two types are supported in Release 3.1:

– Non Video—Used only for playlists that do not include video content.

– Video and Mixed Media—Used for any playlist that contains video content.

• Control Panel > Setup

The following changes have been made:

– The tabs have been renamed.

– The Staging interface has been moved under the Control menu.

User TV Control
Support for all methods of user TV control is enabled by default in Cisco StadiumVision Director. This 
includes control of TV displays using local control devices and applications, IP phones, touch screens, 
and infrared remote (IR) control. 

Some venues have a need to disable user TV control for certain events or suites, or to limit the TV to 
display a particular channel or control its volume.

Cisco StadiumVision Director Release 3.1 introduces two ways for you to disable user control of TVs:

• Defining the “Disable User Control” action in a script.

• Running the “Disable User Control” TV command from the Management Dashboard.

Using one of these two methods, you can disable support for all of the default types of user TV control 
(excluding TV off control). You can also use these methods to re-enable user TV control using the 
corresponding “Enable User Control” script action or TV command.
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You can verify the user TV control state for a particular DMP using the Status Details area of the 
Management Dashboard. Go to the General drop-down menu and look at the value displayed in the User 
Input field as shown in Figure 8.

Figure 8 TV Status User Input Field in the Management Dashboard

Installation Notes 
This section includes the following installation information:

• Installation Requirements for Licensing Compliance, page 28

• Installation Requirements on New Platform 3 Servers, page 28

• Cisco StadiumVision Director Remote OVA Deployment, page 29

• CIMC and BIOS Firmware Installation for Cisco StadiumVision Director Platform 2 Servers, 
page 29

• Important Upgrade Notes, page 30

Installation Requirements for Licensing Compliance
To maintain software licensing compliance, Cisco StadiumVision Director servers must be installed in 
the following manner:

• The Cisco StadiumVision Director server is installed in a data center or in an enterprise data closet.

• The Cisco StadiumVision Director Remote software is installed on the customer’s choice of 
hardware that supports a VMware virtualized environment, or the remote server hardware is 
installed in a data center or in an enterprise data closet.

Installation Requirements on New Platform 3 Servers

Caution New Platform 3 servers (SV-DIR-DIRECTOR-K9 and SV-PLATFORM3=) come preinstalled with a 
preliminary image of Cisco StadiumVision Director that is not intended for production operation. You 
must install the Cisco StadiumVision Director Release 3.1 software from a full ISO image (not an 
upgrade) that you downloaded from Cisco.com to be sure that you are running the released production 
version of Cisco StadiumVision Director Release 3.1. 

For information about installing a fresh ISO image on a Platform 3 server, see the Cisco StadiumVision 
Director Software Installation and Upgrade Guide, Release 3.1.
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Cisco StadiumVision Director Remote OVA Deployment
A known problem in the deployment of VMware OVA templates can occur with the Cisco StadiumVision 
Director Remote OVA template, where sometimes the Linux OS creates a new “eth0” network interface 
and renames the original one to “eth0.bak.” If this happens, ignore the “eth0.bak” interface and configure 
the network using the “eth0” interface.

For more information about installing Cisco StadiumVision Director Remote, see the 
Cisco StadiumVision Director Remote Installation and Upgrade Guide, Release 3.1.

CIMC and BIOS Firmware Installation for Cisco StadiumVision Director 
Platform 2 Servers

Platform 2 (SV-DIRECTOR-K9 or SV-PLATFORM2=) of the Cisco StadiumVision Director server 
requires installation of the Unified Computing System (UCS) Server Firmware Version 1.4(2) or later to 
avoid problems powering off the server hardware.

Verifying the BIOS Firmware Version

You can verify the firmware version installed on Platform 2 of the Cisco StadiumVision Director server 
by running a Basic System State Report from the Cisco StadiumVision Director main menu.

Note BIOS firmware version 1.4.1 is the compatible version packaged with CIMC firmware version 1.4.2.

In the OS Information section of the Basic System State Report, look for “BIOS Information” and 
“Version” below the “Handle 0x00005, DMI type 0, 24 bytes” line, as shown in the following example.

If your version is less than “1.4.1,” then an upgrade is needed:

Handle 0x0005, DMI type 0, 24 bytes.
BIOS Information
Vendor: Cisco Systems, Inc.
Version: C200.1.1.1a.0.032920100525
Release Date: 03/29/2010

Tip If the vendor information in this section is Intel Corporation, and the version begins with 
“S5000,” then this is not a Platform 2 server, but rather a Cisco ADE 2140 Series server. This 
BIOS upgrade process does not apply to the Cisco ADE 2140 Series server.

For more detailed information about verifying the BIOS firmware and instructions about how to 
upgrade, see the “Upgrading the CIMC and BIOS Firmware on a Cisco StadiumVision Director 
Platform 2 Server” module of the Cisco StadiumVision Director Software Installation and Upgrade 
Guide, Release 3.0.
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Important Upgrade Notes
Consider the following important changes that are implemented in Cisco StadiumVision Director 
Release 3.1 for upgrades to existing Cisco StadiumVision Director sites:

• Upgrade Restrictions, page 30

• Upgrade Paths, page 30

• Installation and Upgrade Files, page 31

• Upgrade Process, page 32

Upgrade Restrictions

Caution Upgrade restrictions are identified for the following environments. Contact your Cisco Systems sales 
representative to move these environments to Cisco StadiumVision Director Release 3.1:

—Upgrades to Cisco StadiumVision Director Release 3.1.0-787 (SP1) from Release 3.1.0-510 or 
Release 3.1.0-632 require certain hotfixes to be applied before the upgrade.

—Upgrades to Cisco StadiumVision Director Release 3.1.0-632 software from Release 3.0.0-433 SP2 
are not supported for independent customer upgrade if your existing server has certain customizations. 
Contact your Cisco Systems sales representative for information about your upgrade options.

—Standard upgrades from Cisco StadiumVision Director Release 2.4 on the Cisco ADE 2140 Series 
appliance (CADE-2140-K9) to Cisco StadiumVision Director Release 3.1 are not supported. 

Platform 2 servers require the following minimum configuration to upgrade to Release 3.1:

• The system must be running Cisco StadiumVision Director Release 3.0.0-433 (SP2).

For information about how to upgrade to Release 3.0.0-433, see the Cisco StadiumVision Director 
Installation and Upgrade Guide, Release 3.0.

• Two additional 300 GB hard drives installed for a total of four drives. 

For information about how to add hard drives as part of the Release 3.0 SP2 upgrade to Release 3.1, 
see the “Upgrading a Cisco StadiumVision Director Platform 2 Server from Release 3.0 SP2 to 
Release 3.1” module of the Cisco StadiumVision Director Software Installation and Upgrade Guide, 
Release 3.1.

Upgrade Paths 

Caution As of May 21, 2015, an upgrade to the latest version of Cisco StadiumVision Director Release 4.0 is 
recommended. Otherwise, a service patch is required for Release 3.1.0-797 to fix “CSCuu22735—Flash 
player unable to load Control Panel due to Adobe certificate issue.” section on page 35. The patch 
requires a SNETAC account and must be performed by Cisco Systems Technical Support or field 
delivery personnel.
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Table 14 lists the latest supported upgrade paths for Cisco StadiumVision Director Release 3.1:

Note Localization is not supported in Release 3.1.0-510 or Release 3.1.0-632. Localization support is 
introduced in Release 3.1.0-787.

Table 15 lists the supported upgrade paths for Cisco StadiumVision Director Remote Release 3.1:

Installation and Upgrade Files

Cisco StadiumVision Director Release 3.1 software is available in different types of files based on the 
installation or upgrade environment. 

ISO Files

ISO files are packaged images that are available in two versions:

• An ISO full image—The full ISO file is to be installed only on brand new Cisco StadiumVision 
Director servers that have no prior Cisco StadiumVision Director software version installed.

• An ISO upgrade image—The upgrade ISO file is built for processing using the TUI upgrade utility. 

Note ISO upgrade images are available for both Cisco StadiumVision Director and Cisco StadiumVision 
Director Remote software.

Table 14 Supported Upgrade Paths for Cisco StadiumVision Director Release 3.1

From: To:

Release 3.1.0-787 (SP1)1

1. Upgrades to Cisco StadiumVision Director Release 3.1.0-797 (SP2) are mandatory for all venues. 

Release 3.1.0-797 (SP2)2

2. Release 3.1.0-797 (SP2) requires a service patch, with upgrade to Release 4.0 preferred. The patch must be performed by 
Cisco Systems Technical Support or field delivery personnel. Contact your Cisco representative for more information.

Release 3.1.0-632 plus hotfixes3

3. Upgrades to Cisco StadiumVision Director Release 3.1.0-787 (SP1) from Release 3.1.0-510 or Release 3.1.0-632 require 
certain hotfixes to be applied before the upgrade. Contact your Cisco Systems sales representative to upgrade from these 
releases.

Release 3.1.0-787 (SP1)

Release 3.1.0-510 plus hotfixes2 Release 3.1.0-787 (SP1)

Release 3.0.0-433 (SP2)

Note Sites running Release 3.0.0-429 (SP1) must now 
upgrade to Release 3.0.0-433 (SP2) prior to installing 
Release 3.1.

Release 3.1.0-787 (SP1)

Table 15 Supported Upgrade Paths for Cisco StadiumVision Director Remote Release 3.1

From: To:

Release 3.1.0-205 Release 3.1.0-216
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OVA Files

The Cisco StadiumVision Director Remote software is delivered as an Open Virtual Appliance (OVA) 
template to be installed with a VMware ESXi host.

Software Download

Note You are eligible to obtain information about how to access the Cisco StadiumVision Director full ISO 
file or Cisco StadiumVision Director Remote OVA file after you have purchased the proper licensing. 
Contact Cisco Technical Support for information about how to download these files.

If you have a Cisco CCO account and a contract for software download, you can download the 
Cisco StadiumVision Director installation and upgrade files on the Cisco.com software download site at:

http://www.cisco.com/cisco/software/navigator.html?mdfid=283479662&i=rm

Upgrade Process

Upgrades to the Cisco StadiumVision Director and Cisco StadiumVision Director Remote software are 
made available using the ISO upgrade utility available from the TUI. The ISO upload utility uses a 
special upgrade ISO file available from the Cisco.com software download site.

For Cisco StadiumVision Director, there are two upgrade environments for Release 3.1, which have 
different upgrade requirements:

• Upgrading an existing server from Release 3.0.0-433 Service Pack 2 to Release 3.1.

Depending on your server environment, this requires you to upgrade DMP firmware, install 
additional hard drives, upgrade CIMC/BIOS, and perform the ISO upgrade.

• Upgrading an existing server already running Release 3.1 to a more recent 3.1 release.

This environment generally requires that you only perform an ISO software upgrade.

For more details about upgrading the Cisco StadiumVision Director software for your environment, see 
the Cisco StadiumVision Director Software Installation and Upgrade Guide, Release 3.1.

For more details about upgrading the Cisco StadiumVision Director Remote software for your 
environment, see the Cisco StadiumVision Director Remote Installation and Upgrade Guide, Release 
3.1.

VLAN Compliance Check

A VLAN compliance check for DMPs is supported in Cisco StadiumVision Director Release 3.1. After 
you upgrade to release 3.1, you need to go to the Management Dashboard and change the Assigned 
VLAN property under Global DMP Settings for both the 4310 and 4310 v5.2.3 settings according to your 
DMP VLAN configuration as follows:

• If all of your DMPs are located on the same VLAN (recommended)—Type the number of the VLAN 
and save the configuration.

• If all of your DMPs are not located on the same VLAN, or you want to bypass any VLAN 
compliance checking—Type “$svd_ignore” and save the configuration.

Note The default Assigned VLAN property value is $svd_ignore.
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The value in the Assigned VLAN property in the Management Dashboard settings for the 
DMP 4310s is checked against the value being sent by the DMP, unless you have configured 
$svd_ignore.

Caution DMP auto-registration support requires that the VLAN value is correctly set or “$svd_ignore” is used.

Figure 9 shows how to configure the Assigned VLAN property under the 4310 Settings for DMPs 
that are not located on the same VLAN using the “$svd_ignore” string. 

You will also need to set this Assigned VLAN property value for the 4310 v5.x.x Settings:

Figure 9 Assigned VLAN Property Configuration for DMPs 

Limitations and Restrictions 
When using Cisco StadiumVision Director Release 3.1, be aware of the following limitations and 
restrictions:

Caution Proof of play raw data repository in /var/sv/pofp/raw directory is not part of the backup process. In 
normal operation, a completed script with a green dot already has a copy of the raw data and is part of 
the backup data. No further action is needed aside from generating the PoP report. For completed scripts 
that do not have a green dot, it is very important to investigate or call for support within 60 days of the 
event, after which time the PoP messages in the raw directory will be deleted.

• If you have previously accessed a different Cisco StadiumVision Director version on your computer, 
sometimes unexpected behavior or warnings arise, or you might access an older version of the 
interface. In this case, and especially after an upgrade, you must clear your browser cache.
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• The first release of Cisco StadiumVision Director Release 3.1 implements the infrastructure only to 
support i18n and L10n to support the independent installation of other language packs with Cisco 
StadiumVision Director Release 3.1 as they become available. Language support for Release 3.1 is 
introduced in Release 3.1.0-787 (SP1). See the “Service Packs for Localization” section on page 23.

• Cisco StadiumVision Director Release 3.1 does not support internationalization for back-end 
messaging.

• Non-English characters are not supported as a Cisco StadiumVision Director login credential.

• Multi-user support in Cisco StadiumVision Director Release 3.1 is limited to script editing only. No 
other Control Panel functions for templates, zones, groups, and playlists support a multi-user 
environment, and these areas can be deleted by other users. However, users are notified about 
potential impact due to currently locked scripts and are prompted for confirmation of deletion and 
given an option to use instant messaging to coordinate with the script owner.

• No more than 10 users can be supported at any one time in the Management Dashboard and Control 
Panel areas. The system does not prevent more than 10 sessions to be opened, so you need to be 
careful that you do not exceed this limit.

• No more than 50 staging threads can be processing in Cisco StadiumVision Director at any one time. 
The default maximum is 10. The maximum is configured using the “stagingThreadNum” registry 
found under the Tools > Advanced > Registry section of the Management Dashboard.

Note If auto-registration is enabled and a new DMP is detected, then Cisco StadiumVision Director 
initiates staging and always uses 50 as the maximum value. In this case, the stagingThreadNum 
registry setting is ignored and remains unchanged. 

• Consider the following restrictions and expected behavior when configuring playlists:

– Single video loop—You can configure a playlist to loop continuously when you have a playlist 
with a single video content item set for a duration of zero, with the playlist duration also set to 
zero.

– Single non-video loop—You can configure a playlist to loop continuously when you have a 
playlist with a single non-video content item by setting the item duration to -1, and setting the 
playlist duration to a number greater than or equal to zero.

– All playlists will loop their content (for example, once the last item plays, the playlist restarts 
with the first item) unless a duration of zero is configured on the first playlist item.

– To run a playlist one time, you can specify a duration of zero for the last item in the playlist. 
There is different behavior if the last item is a non-video item versus a video. If the last item 
has zero duration, and once the rest of the playlist items run, then if the last item is a non-video 
item, it continuously plays for the duration of the state. If the last item is a video, the video plays 
one time followed by a black screen for the duration of the state.

– If a change is made to a playlist and the playlist is currently being displayed, it is possible that 
items in the playlist that are past an item in the playlist with a duration of zero, could get 
displayed and the playlist continues until the item with zero duration is reached again.
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Important Notes
This section includes other important information about the Cisco StadiumVision solution that you 
should know for optimal operation.

DMP Maintenance Recommendations
To avoid unexpected behavior and maintain normal operation of your devices, it is highly recommended 
that you perform a soft reboot of all of the DMPs in your system each week. You can reboot DMPs 
manually or configure a periodic task to run automatically.

Note Before you perform a reboot, be sure that there are not any active scripts running.

For more information see the “How to Configure the Reboot DMP System Task From the Management 
Dashboard” task note.

Caveats 
• Open Defects in Cisco StadiumVision Director Release 3.1.0-797, page 35

• Resolved Defects in Cisco StadiumVision Director Release 3.1.0-797, page 37

• Open Defects in Cisco StadiumVision Director Release 3.1.0-787, page 38

• Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787, page 42

• Open Defects in Cisco StadiumVision Director Remote 3.1.0-216, page 45

• Resolved Defects in Cisco StadiumVision Director Remote 3.1.0-216, page 46

• Open Defects in Cisco StadiumVision Director Release 3.1.0-632, page 46

• Resolved Defects in Cisco StadiumVision Director Release 3.1.0-632, page 48

• Open Defects in Cisco StadiumVision Director Release 3.1.0-510, page 48

Open Defects in Cisco StadiumVision Director Release 3.1.0-797
This section lists the defects that are open in Cisco StadiumVision Director Release 3.1.0-797. These 
defects are open in addition to those defects open in Release 3.1.0-787 that are not yet resolved in 
Service Pack 2. 

CSCuu22735—Flash player unable to load Control Panel due to Adobe certificate issue.

Symptom

Some time on 5/5/2015, the ability to load the Cisco StadiumVision Director Control Panel was reported 
from the field and also reproduced in the Cisco lab. The Control Panel will start to load but will remain 
at 0% on screen. Before 5/5/2015 there were no issues in loading Control Panel.
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Solution

A certificate in the Adobe library expired without announcement to the development community causing 
applications that utilize the Adobe library to cease operating on or after 5/6/2015. Adobe has since 
provided updated versions of their libraries with updated certificates. A service patch is available for 
Cisco StadiumVision Director Release 3.1.0-797, or you can upgrade to the latest released version of 
Cisco StadiumVision Director.

Recommended Action

• (Highly Recommended) Perform upgrades to your system to reach the latest Cisco StadiumVision 
Director Release 4.0 version.

-or-

• Apply a service patch to your existing Release 3.1.0-797 system. The patch requires a SNETAC 
account and must be performed by Cisco Systems Technical Support or field delivery personnel. 
Contact your Cisco representative for more information.

Temporary Workaround (Until upgrade is completed or patch is applied)

Use Mozilla Firefox to access Cisco StadiumVision Director once you have completed the workaround 
steps below. You may have to complete the steps daily.

Complete the following steps to reset the Mozilla Firefox browser:

1. Do the following based on your computer model:

– On a PC, clear the browser cache from Control Panel > Flash Player Settings Manager.

– On a Mac, clear the browser cache from System Preference > Flash Player.

2. Select the Storage tab, click Delete All.

3. Click Confirm.

4. Select the Advanced tab, under Browsing Data and Setting, click Delete All.

5. Go to the following URL using a Firefox browser on your PC or Mac:

http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager03.html

6. Uncheck “Store common Flash components to reduce download times”.

7. Click Confirm.

8. Close all Firefox sessions and verify that all sessions are closed.

9. Open a new Firefox session.

10. Launch Cisco StadiumVision Director.

CSCuj36588—Content replacement sometimes pushes new content to undesired DMPs.

Symptom When running event scripts with the warning “Device(s) appear multiple times in zone/group 
mapping,” and performing a content replacement operation, staging can send additional unnecessary 
files to many DMPs.

Workaround Fix the event script to remove the warnings “Device(s) appear multiple times in zone/group 
mapping.”
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CSCuj07468 —”Content Manager” role unable to upload content using Google Chrome and Microsoft IE.

Symptom When logged in to Cisco StadiumVision Director with the Content Manager role, content 
upload says complete but content does not appear in the content list.

Workaround Use the Mozilla FireFox browser when logged in as Content Manager, or log in with the 
Administrator role if you need to use other supported browsers.

Resolved Defects in Cisco StadiumVision Director Release 3.1.0-797
Table 17 lists the defects that are resolved in Cisco StadiumVision Director Release 3.1.0-797:

Table 16 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-797

Resolved Defect 
Numbers Description of Original Defect

CSCuj43168 Integration server is not recognizing a “databind.maxUpdateInterval” registry 
setting less than 60000.

CSCui94686 Checkbox within dropdown does not hold selection after focus goes away.

CSCui88787 Log retention time needs to be decreased because of increased disk usage.

CSCui77170 CMS randomly loses connection with MySQL overnight. 

CSCui72577 Icon/channel number does not display correctly if you set the channel favorite 
numbers in a random order—for example, when channel 1 is not favorite 
number 1 and channel 2 is not favorite number 2.

CSCui72284 Speeddial does not seem to be working with Cisco StadiumVision Director app 
and CUCM version 9.0.

CSCui69847 In some cases script validation errors need to be changed to warnings to be 
consistent with the same script behavior in Release 3.0. 

CSCui69281 The dmp_status.csv file in the System State Report is empty.

CSCui65588 The ntpd service is off in chkconfig for Release 3.1 SP1 fresh ISO installations.

CSCui63978 Proof of Play data is not restored during restore process. 

CSCui63856 Proof of Play cookie that contains "+" causes report generation to fail.

CSCuh73996 Syslog message is being sent per DMP per each set state message while script 
is running.
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Open Defects in Cisco StadiumVision Director Release 3.1.0-787
This section lists the defects that are open in Cisco StadiumVision Director Release 3.1.0-787. These 
defects are open in addition to those defects open in Release 3.1.0-632 that are not yet resolved in 
Service Pack 1. 

CSCuh61780—Using zip file to replace content will create new version of content with the same name.

Symptom Existing file content is not replaced when you upload files of the same name within a zip file.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Log into Cisco StadiumVision Director and go to Control Panel > Content.

2. Upload files.

3. Create a different version of the file(s) (different content) using the same name and create a zip file 
containing those file(s).

4. Upload that zip file.

Workaround When trying to replace file(s) using the same name, upload the actual file(s) instead of 
uploading a zip file that contains those file(s). 

CSCuh58919—When uploading contents using a zip file those contents will not be added to any designated tags.

Symptom After uploading the zip file the tag(s) will be created but they will not have any content in them. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Prepare a zip file with content (e.g. jpeg files). 

2. Log into Cisco StadiumVision Director and go to Control Panel > Content.

3. Click Import.

4. Select the zip file.

5. In the Import Content dialog create or use exiting tag(s) and move them over to the column on the 
left.

6. Click Upload. 

Workaround After the upload process the items that you uploaded are all selected. Manually click and 
drag them into the tag(s). 

CSCuh39211—After fresh ISO install DMB application fails to load in non-English languages.

Symptom The Dynamic Menu Board (DMB) application fails to load non-English languages. However, 
this only occurs immediately after a fresh ISO installation. After a server reboot this issue will no longer 
occur. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Perform a fresh installation using a full ISO image.
38
Release Notes for Cisco StadiumVision Director Release 3.1

 



  

  Caveats
2. After the installation is complete launch the Cisco StadiumVision Director web UI with the browser 
locale set to a non-English but supported language (e.g. de_DE).

3. From the Cisco StadiumVision Director main menu, launch the Dynamic Menu Board application. 

Workaround After the fresh installation restart the Config server using the TUI.

CSCuh34158—TUI upgrade ISO selection does not work for integers that end digits between 3–9.

Symptom Users seeking to upgrade the system might encounter difficulties if their upgrade ISOs fall 
within the range of the numbers that the option parser has a problem with. The ISO selector prompt does 
not accept your input and asks you again for a new selection. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. You have uploaded 3 or more ISO files to Cisco StadiumVision Director.

2. Log into the TUI as an installer using a KVM console.

3. Select StadiumVision Server Administration (Option d).

4. Select Upgrade Server (Option b).

5. Once the list of ISO options is presented to you, enter any values between 3 and 9 (inclusive). 

Workaround Type “0n” in front of the integer value “n” that corresponds to the ISO file that you want to 
upgrade. For example, to select the fourth ISO file in the list, type “04” and press Enter. For future, you 
can also remove old upgrade ISO files to free up disk space.

CSCuh29150—Force button does not do anything when moving locations that are part of a suite.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Setup > Venue > Locations and assign several DMPs that are not part of 
any group to the venue.

2. Switch to Control Panel > Setup > Suites.

3. Select a suite from Suite list and click Locations.

4. Assign a couple of locations from Step 1. to a suite and Save.

5. Go back to the Venue tab and try to reassign the DMPs that are in a suite to a different venue.

6. If a “Remove & Reassign” appears, press Ok.

7. Click Save and a warning appears about conflict errors with other objects.

8. Click Force button. Nothing happens.

9. Repeats Steps 5-7 with locations that are not part of suites. The Force button works.

Workaround Remove the Locations from suites before reassigning to another venue.
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CSCuh23341—Schedule screen filter is carried over to Control screen and vice versa.

Symptom You cannot see the entire list of scripts available after you have searched for a particular script 
and then switch screens. You see the same number of scripts that you saw on the Schedule screen after 
using the search filter. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Schedule.

2. Use the search box to look for a particular script.

3. Go to the Control screen. 

Workaround You can see the full list of scripts after using the search filter by completing the following 
steps:

1. Go back to Schedule screen. 

2. Clear the search filter. 

3. Go back to Control screen. 

CSCug87896—Modifying a template that is already in use will not cause it to automatically update in script state editor.

Symptom After a template is edited, the template being displayed in the state editor of a script is the old 
version, before the template was edited. Therefore, any changes made in the editor might cause an issue 
since template region types or even a region’s existence might conflict with the version being presented 
for editing. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Log into the Cisco StadiumVision Director.

2. Go to Control Panel > Setup > Templates.

3. Create a new template and save it.

4. Go to Schedule.

5. Create a new script.

6. Add a new state.

7. Set state to use your newly created template.

8. Save state and script settings.

9. Go back to Setup > Templates.

10. Change the template you created in some way (add/remove) regions.

11. Save template changes.

12. Go to script.

13. Open the script you created and edit the state with the template that you created. 
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Workaround Complete the following steps:

1. Reload the UI.

2. Open the script for edit.

3. In the state editor, remove the template that was modified and then add it again. 

CSCuf51989—DMP firmware version 5.4 limits SSC albums to 24 content pieces.

Symptom The SSC album widget fails to load and the SSC album will not be presented when user tries 
to play it. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Upgrade a Cisco 4310 DMP to version 5.4 firmware.

2. Create an SSC user and assign it to an existing luxury suite.

3. Log into the SSC portal using a newly created SSC user.

4. Create a new album that has 25 or more pieces of content.

5. Save and publish the album.

6. Once publish has been completed, use an IP phone or local control API to start that album's 
playback. 

Workaround Only use 24 or less content items when using DMP firmware version 5.4. 

CSCuf39254—Unaassigned category is missing in Management Dashboard venue selector.

Symptom In Cisco StadiumVision Director deployments where multi-venue feature is enabled, there is 
no unassigned category in the Management Dashboard venue selector. This prevents users from seeing 
all DMPs that are not assigned to a venue. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Log in as an administrator to a Cisco StadiumVision Director server that has been enabled for 
multiple venue support.

2. Go to Control Panel.

3. Go to the Venue Selector drop-down box located in the top right side of the screen. Scroll to the 
bottom of that list and you will see an 'unassigned' category.

4. Go to the Management Dashboard.

5. On the top right of the Dashboard you can see “Choose Venue : ALL.”

6. Clicking All shows all the venues configured for that Cisco StadiumVision Director server.

7. Scrolling through that list there is no Unassigned category in that list. 

Workaround Use a logical name for all global DMPs (such as “GL” or “AL” or something similar) so 
when sorted/filtered by name those unassigned DMPs will be grouped together. 
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CSCuf39135—DMP flash crashes when widget component resizes png of certain size.

Symptom DMP flash crashes when widget has a graphics or default image for PicToScreen component 
set to resize a 1920x1080 png to 1920xHeight where Height is 400 or less. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Create a widget.

2. Add Graphic component on the canvas.

3. Load a 1920x1080 image from content directory.

4. Resize image height from 1080 to 400 or less.

5. Save the widget and add into playlist.

6. Run the script.

Workaround Avoid using an image that is 1920x1080 in size (for the graphic or default image for 
PicToScreen components) and resizing it to 400 or less. 

Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787 
Table 17 lists the defects that are resolved in Cisco StadiumVision Director Release 3.1.0-787:

Table 17 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787

Resolved Defect 
Numbers Description of Original Defect

CSCuh56152 Script state action editor preview feature (the “eye” icon) not working.

CSCuh56118 Content image preview for cloning content multiple times not working.

CSCuh53997 Assigning actions to script page does not load correctly after SP1 upgrade.

CSCuh47730 Force script start dialog on validation error is missing the “Yes” button.

CSCuh36946 Incorrect root setting for admgr user causes KORE feature to break. 

CSCuh33606 Unable to create new groups using BAT tool.

CSCuh23441 T2S component textcolor is not changing for first and last message when total 
message count is an odd number.

CSCuh18348 Unable to deploy a GSIS Stats data source. 

CSCuh10648 Registry values “databind.minUpdateInterval” and “max” needs to change. 

CSCuh02454 Datasource config property goes back to default value when value set to zero.

CSCuh02036 The search box does not work under Venue > locations > assigned loc tab. 

CSCuh01769 In Management Dashboard default for “Check for location mismatch” should 
be “no.” 

CSCuh01448 Incoming data filter rate cannot be set in External Content Integration.

CSCuh01304 /var/sv/RESTORE/backup deleted due to nature of 3.0 SP2 backup fix.

CSCuh01255 For data integration, minUpdateInterval and maxUpdateInterval are in seconds.
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CSCug95682 Daktronics/Basketball protocol does not work with Cisco StadiumVision 
Director. 

CSCug98394 Staging status does not get updated for a script when content is not using a Cisco 
StadiumVision Director Remote server.

CSCug93791 Multiple script or playlist cannot be selected during venue association.

CSCug92376 Existing albums do not update after adding locations to an SSC account.

CSCug92362 Existing albums do not toggle to unpublished state after locations added. 

CSCug92328 Published albums are not available for playback.

CSCug88212 Filter gets reset once an object is associated with a venue in Venue tab.

CSCug82382 Playlist content list scrolls back to the top after adding content.

CSCug80731 Cisco StadiumVision Director UI missing button breaks content replacement 
during event.

CSCug80716 PicToScreen component display size on TV affected by default image size. 

CSCug72733 Using Microsoft IE 9, only control panel icon gets loaded on the landing page. 

CSCug72616 In Content screen “Create Thumbnail” feature for SWF files not working. 

CSCug72578 A deleted widget still appears in Content screen of Control Panel.

CSCug70165 Unconfigured triggers should display “Not configured” name.

CSCug70133 /opt/sv/servers/mule/apps/svd is not backed up.

CSCug70074 String populated on new user’s name should not use UUID. 

CSCug66389 Restoring to a server with a different IP address causes broken vdo thumbnail.

CSCug66190 Replacing content in CM fails when filename size is greater than 24.

CSCug60297 In the Management Dashboard dropdown “Location Mismatch” and “Normal” 
not working. 

CSCug59817 User should not be able to configure two video regions. 

CSCug57969 DMP IP uniqueness check not working at all.

CSCug57835 Orphan content in CMS blocks user from uploading content with same name in 
Cisco StadiumVision Director.

CSCug54161 Simplified Chinese translation error.

CSCug49862 Backup retention policy saves one more backup copy than it states in TUI.

CSCug49838 User gets an exception when saving a venue.

CSCug46903 Cisco StadiumVision Director restore takes too much time when content is 
large. 

CSCug44056 Location status in Management Dashboard sometimes does not reflect changes. 

CSCug41467 Venue management UI should not direct user to change settings on registry. 

CSCug41273 Cisco IP phone screen not rendered correctly when using Simplified and 
Traditional Chinese languages.

CSCug38407 Logging and monitoring levels are set initially to debug. 

CSCug35954 Batch delete contents with a widget causes content corruption. 

Table 17 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787

Resolved Defect 
Numbers Description of Original Defect
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CSCug35429 Unset default global JMX credentials causes errors venue creation. 

CSCug30208 Content Manager UI should not display corrupted content as blank lines. 

CSCuf30156 Deleting widget that is assigned to playlist not giving error message. 

CSCug29887 Retry upload button fails to upload content that failed to be uploaded in first 
attempt in Content screen. 

CSCug29722 Script stays stuck at Starting because of defective content in playlist.

CSCug25067 Cannot set “Use image original size” in Widgets tool for PicToScreen 
component. 

CSCug25063 TextToScreen preview fade duration not changing corresponding to “Text 
Duration” property value.

CSCug25049 PicToScreen preview images are not changing corresponding to “Images to 
display” property value.

CSCug25004 Unable to resize PicToScreen component.

CSCug23070 Cancel staging job in UI does not work. 

CSCug17764 Get Status inaccurate after DMP first provisioned. 

CSCug08634 Playlists' type can be changed even after it has been saved.

CSCuf95995 Multiple tags with same names can be created.

CSCuf86524 Allow single image presentation in PicToScreen component. 

CSCuf85688 DMP failover needs to be disabled. 

CSCuf74190 Scheduling an event script for the future fails when using the Swedish language 
in Cisco StadidumVision Director.

CSCuf71129 In Dashboard GetStatus reports inaccurate RS-232 status. 

CSCuf68052  /var/log migration scripts create extra /var/log/svd-xxx/svd-xxx symlink.

CSCuf66333 UI sometimes misorders staging jobs when sorted by start time. 

CSCuf66133 Venue deletion is always warned of resource associated.

CSCuf61294 BAT tool improperly considers site info valid if “Time Zone” is missing.

CSCuf61255 Multiple ContentRoot created in CMS when first upload has multiple files. 

CSCuf58418 When All Venues is selected modifying a playlist dissociates it from the venue.

CSCuf39183 Widget cached data causes problems when closing and reopening the same file. 

CSCuf39176 “Duplicate selected layer” data binding sometimes does not work during copy.

CSCuf39169 Widget font size/color fields on Properties tab do not reflect current settings. 

CSCuf39164 Widget “Content Name” field property does not reflect current changes. 

CSCug37996 Output trigger types need to have include strings for user consumption. 

CSCuf30382 Criteria to delete a venue is not uniform. 

CSCuf30326 Message missing to user that cannot delete last item in running playlist. 

CSCuf30249 In Content screen aspect ratio/fps metadata not display by the UI. 

Table 17 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787

Resolved Defect 
Numbers Description of Original Defect
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Open Defects in Cisco StadiumVision Director Remote 3.1.0-216
This section lists the open defects in Cisco StadiumVision Director Remote 3.1.0-216.

CSCuh20641—In Cisco StadiumVision Director Remote TUI Setup Staging Parameters Menu Options Allow Invalid Values.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Log into the Cisco StadiumVision Director Remote TUI.

2. From the Main Menu, go to System Settings > Network Settings > Setup Staging Parameters.

3. Go to one of the sub-menu options: 

a. Days to keep content 

b. Number of staging threads 

c. Milliseconds wait for timeout

4. Enter an invalid value:

For example, “f7” is rejected, but “7f” or “7abcdef” is accepted and written into the 
“staging.properties” file. 

Workaround Double-check that the value entered is a valid number. 

CSCuf30218 Cisco IP phone pagination strings get covered by Cisco StadiumVision Director 
phone service UI.

CSCuf30187 Changing Text component color highlight in Layers box jumps from component 
being edited.

CSCuf30179 In Control Panel Channel Icon tab unable to remove Icon association. 

CSCuf24727 New widget not appearing in Content screen until refresh button is clicked. 

CSCuf24701 If host name changed during fresh ISO install mule and CMS need restart. 

CSCuc42948 When using Microsoft IE9, the Cisco StadiumVision Director Control Panel 
does not work (unable to be clicked). 

CSCub76220 After adding item to large playlist in Control Panel, the list resets to the top. 

CSCub73503 Staging a template sometimes fails with “unable to fork low free memory” error.

CSCua96689 New instances of widgets are not blocked from being added to a running script.

CSCua76981 In Serial Commands page using scroll bar causes “*” to appear. 

CSCua66283 Request album publish multiple times causes unreliable state reporting.

CSCua58461 Config server runs out of heap memory when bringing up dashboard with 5000 
DMPs.

CSCty99710 Newly created channel not immediately available for assignment in guide. 

CSCty58781 Text field is blank when it is assigned to databinding. 

Table 17 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-787

Resolved Defect 
Numbers Description of Original Defect
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Resolved Defects in Cisco StadiumVision Director Remote 3.1.0-216
Table 18 lists the defects that are resolved in Cisco StadiumVision Director Remote 3.1.0-216:

Open Defects in Cisco StadiumVision Director Release 3.1.0-632
This section lists the defects that are open in Cisco StadiumVision Director Release 3.1.0-632.

CSCuf71129—Management Dashboard GetStatus reports inaccurate RS-232 status.

Symptom GetStatus always reports a “green” RS-232 status even if a DMP has an RS-232 issue. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Have a DMP available that has a known RS-232 issue. 

2. From the Management Dashboard perform a GetStatus.

Note that the RS-232 status turns completely “green” which is incorrect.

3. Perform a Ping to the device.

Note that the RS-232 status now shows the upside down triangle which is the correct status. 

Workaround Performing a Ping will report the correct status. 

CSCuf51989—DMP 4310G firmware version 5.4 limits SSC albums to 24 content items.

Symptom The SSC album fails to load and its content is not displayed on the TV.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Upgrade the DMP 4310 to firmware version 5.4.

2. Create an SSC user and authorize the user for a luxury suite.

3. Using the SSC user account, log into Cisco StadiumVision Director to go to the SSC portal.

4. Create a new album that has 25 or more pieces of content.

5. Save and publish the album.

6. When publishing is complete, use the IP phone or the local control API to start playing the album.

Workaround Do one of the following:

• Use DMP firmware version 5.3.4 if you do not need to support the new functionality in DMP 
firmware version 5.4 but must create albums with more than 24 content items.

Table 18 Resolved Defects in Cisco StadiumVision Director Remote Release 3.1.0-216

Resolved Defect 
Numbers Description of Original Defect

CSCug30126 Need Cisco StadiumVision Director Remote TUI option to change Cisco 
StadiumVision Director Remote content expiration setting. 
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• Create albums with 24 or less content items with DMP firmware version 5.4.

• If you need to support albums with greater than 24 items in DMP firmware version 5.4, go to the 
Management Dashboard > Tools > Advanced > Registry. Click Add Row. In the Key box, type 
widget.slideshow.items.maximum. In the value box, type 24. Click Apply. This will allow you to 
support loading an album with greater than 24 items, but only the first 24 items will be played on 
the TV.

CSCuf29911—’Force Delete' does not delete venues if content is tagged with a venue tag.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Create a venue.

2. Go to Control Panel > Content and locate the system tag corresponding to the new venue that was 
created.

3. Drag and drop some content into that venue system tag.

4. From the venues tab, associate a few of the locations or scripts to the venue.

5. Go to Setup > Venues and try to delete the venue by pressing the red “-” icon.

6. The “Force Venue Delete Confirm” message is displayed. 

7. Click Force. 

Workaround Manually disassociate all the objects (including content that is tagged with venue tags in the 
Content interface), and then delete the venue. 

CSCuf24727—New widget not appearing in content tab until refresh button is clicked.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Content.

2. Click Widgets and create a new widget.

3. Go back to the Content tab and note that the newly-created widget is not listed. 

Workaround Click the green Refresh icon.

CSCuf24701—If host name changed during fresh ISO install External Content Integration and CMS services need restart.

Symptom The CMS server is not running and the External Content Integration service is running but is 
not fully functional.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Start a fresh ISO installation. 

2. When the configuration dialog box appears, change the host name and IP address from the default 
of “sv-director” and “10.10.10.10”.

3. Let the installation finish. 

Workaround After installation login to the TUI and restart Cisco StadiumVision Director software by 
going to Main Menu > StadiumVision Director Server Administration > Restart StadiumVision 
Director Software.
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Resolved Defects in Cisco StadiumVision Director Release 3.1.0-632
Table 19 lists the defects that are resolved in Cisco StadiumVision Director Release 3.1.0-632. 

Open Defects in Cisco StadiumVision Director Release 3.1.0-510
This section lists the defects that are open in Cisco StadiumVision Director Release 3.1.0-510. 

CSCuf39019—In Content screen replacing multiple files at once might sometimes fail.

Symptom When uploading multiple (more than 1) content items at once to replace existing content (same 
filename but different content), only some of the files might get replaced.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Content.

2. Upload some files (such as 5).

3. Using a different set of files, rename them to match the names of the 5 files that you have just 
uploaded. 

4. Upload the new files.

Table 19 Resolved Defects in Cisco StadiumVision Director Release 3.1.0-632

Resolved Defect 
Numbers Description of Original Defect

CSCuf39019 In Content screen replacing multiple files at once might sometimes fail.

CSCuf24673 Mixed template to mixed template state transition fails to stop video.

CSCuf24701 If host name changed during fresh ISO install External Content Integration and 
CMS services need restart.

DE1346 After changing Cisco StadiumVision Director Remote credentials "Setup > 
Venues" tab needs reload.

DE1435 After GetStatus on a non-compliant DMP, the Management Dashboard shows 
green status.

DE1457 In the init.swf “DMP Location = “ seems to be always blank.

DE1473 Unable to copy a widget in the Widgets tool.

DE1489 After disassociate multiple locations from a venue, the UI becomes out of sync.

DE1500 No error when binding a Text Area component in the Widgets tool to 
RSS/ATOM/Generic feed.

DE1513 In Widgets tool, default selection for Text Effect does not work.

DE1515 Venue operator cannot see the staging tab under control panel.

DE1522 Unable to upload a channel icon.

DE1525 SSC albums do not work for DMP locations that are associated with a Cisco 
StadiumVision Director Remote server venue.
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Workaround Upload a single file at a time when replacing existing content.

CSCuf24673—Mixed template to mixed template state transition fails to stop video.

Symptom If the first item in the mixed media playlist for the destination state is a static image (jpeg, png, 
and so on), then the video continues to play in the background until the video finishes. At that point it 
will not go on to the next video in the playlist. The expected behavior is the video playback should stop. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Create a state in a video playlist with several videos and another state with static content (jpeg, png, 
etc.) playlist and both using a mixed media template. 

2. Try using static content that is smaller than the region so the background shows through, so that it 
is easier to see the issue.

3. Increase the TV volume.

4. Start the script and go to the video playlist state.

5. Then, go to the static content state. 

Workaround Avoid using static content (jpeg, png, and so on) as the first item in a mixed media playlist 
using a mixed template. If the static content state uses a non-video template then there is no issue. It is 
an issue for a mixed region state change to a mixed region.

DE1525 - SSC albums do not work for DMP locations that are associated with a Cisco StadiumVision Director Remote server 
venue.

Symptom For suite locations associated with Cisco StadiumVision Director Remote server venues, the 
CMS fails to publish an SSC album, but SSC shows that the publishing was successful. The files are 
copied to the DMP even though the CMS internally shows that staging failed.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Enable Cisco StadiumVision Director for multiple venue support.

2. Create a venue and make sure that a working Cisco StadiumVision Director Remote server is 
attached to that venue.

3. Assign a set of DMPs+Locations to the venue.

4. Create a luxury suite and assign one or more of your venue DMPs to the suite.

5. Create an SSC user and authorize all of the luxury suite DMPs for the SSC user.

6. Log into Cisco StadiumVision Director as the SSC user to go to the SSC portal.

7. Create a new album with some content in it.

8. Publish the album.

Workaround There is no workaround. Do not authorize remote DMP locations for SSC users.
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DE1522 - Unable to upload a channel icon.

Symptom The icon does not appear after an upload seems to have succeeded.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to the Control Panel > Setup > Channels.

2. Click the Icon tab.

3. Click Upload Icon.

4. Select a file to upload.

5. Click Upload.

Workaround Contact your Cisco Systems representative.

DE1515—Venue operator cannot see the staging tab under control panel.

Conditions The following steps recreate the conditions when this defect occurs: 

1. From Control Panel > Setup > Users, create a user with the venue operator user role.

2. Log into Cisco StadiumVision Director as the venue operator.

3. Go to Control Panel > Control, the Staging button is not visible. 

Workaround There is no workaround.

DE1513—In Widgets tool, default selection for Text Effect does not work.

Symptom In the Widgets tool, if you leave the Text Effect option on the default selection of “Select 
Effect” the component does not function correctly. 

Workaround After placing a Text Area component on the widget canvas, be sure to select a Text Effect 
of either “none” or “fade” in the Effects tab. 

DE1500—No error when binding a Text Area component in the Widgets tool to RSS/ATOM/Generic feed.

Symptom In the Widgets tool, if RSS, Atom, or generic feed data is bound to a “Text Area” component 
the data binding fails to save.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Widgets. 

2. Create a new widget and drag-and-drop a Text Area component onto the canvas.

3. In the Data Binding tab, bind the field to an RSS, Atom, or generic feed.

4. Save and close the widget and then reload the UI.

5. Open the widget that you just created. Notice that the data binding was not saved.

Workaround To use data binding with RSS, Atom, or generic feeds, use the TextToScreen or PicToScreen 
components in the Widgets tool. 
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DE1489—After disassociate multiple locations from a venue, the UI becomes out of sync.

Symptom In Control Panel > Setup> Venues > Locations tab, when removing multiple locations from 
the Assigned Locations box to the Available Locations box, not all locations are shown as moved to 
Available Locations. The move-right button (>>) is also grayed out. Sometimes more than one location 
will be left in the Assigned Locations box, but at least one location is always left in the Assigned 
Locations box. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Setup > Venues and select a venue.

2. Select the Locations tab and add multiple locations to the venue by selecting the locations and 
clicking the << button.

3. Click Save. 

4. Select all of those DMP locations that you just moved to the left and click on the >> button.

Notice that at least one location (sometimes even multiple locations) is still left in the Assigned 
Locations box. However, the >> button is disabled preventing the user from moving the location.

5. Save the changes and refresh the browser. 

The leftover DMPs are still assigned to the venue. 

Workaround Unselect and then reselect the locations that are still left in the Assigned location panel. This 
will enable the >> button. Then, click >> to remove the DMPs from the Assigned box and click Save. 

DE1475—New widget not appearing in content tab until refresh button is clicked.

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Content. 

2. Go to Widgets and create a new widget.

3. Go to the Content panel. The widget is not displayed.

Workaround Click on the green refresh icon. 

DE1473—Unable to copy a widget in the Widgets tool.

Symptom There is not a menu option to copy a widget in the Widgets tool.

Conditions Go to the Control Panel and select Widgets. 

Workaround There is no workaround.
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DE1457—In the init.swf “DMP Location = “ seems to be always blank.

Symptom On the TV, the “Init Swf” appears in the lower half of the screen and displays DMP 
configuration information, but the “DMP Location” has no information. 

Conditions In the Management Dashboard, run TV Commands > Show Init Swf for a DMP.

Workaround There is no workaround.

DE1435—After GetStatus on a non-compliant DMP, the Management Dashboard shows green status.

Symptom The status symbol for the non-compliant DMP is fully green even though it should be green 
with a yellow triangle. 

Conditions In the Management Dashboard, perform a GetStatus on a DMP that is non-compliant. 

Workaround In the Management Dashboard, run the Ping command immediately after GetStatus. This 
corrects any green status symbols that were in error.

DE1408—If host name changed during fresh ISO install, CMS and External Content Integration services need restart.

Symptom The CMS server is not running, and the Integration Broker (External Content Integration) 
server is running, but is not fully functional. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Start a fresh ISO installation. 

2. When the configuration dialog appears, change the host name and IP address from the default of 
“sv-director” and “10.10.10.10.”

3. Let the installation finish. 

Workaround After installation, log into the TUI using the Installer account. Restart the 
Cisco StadiumVision Director software by going to Main Menu > StadiumVision Server 
Administration > Restart StadiumVision Director software.

DE1346—After changing Cisco StadiumVision Director Remote credentials "Setup > Venues" tab needs reload.

Symptom If the Venues panel in Control Panel is already open in a user’s browser, and then the user 
modifies the Cisco StadiumVision Director Remote JMX credentials in the Management Dashboard, the 
user must reload the Venue panel before creating a new venue. Otherwise, the old credentials for the 
Cisco StadiumVision Director Remote server are assigned to the new venue, instead of the modified 
credentials. 

Conditions The following steps recreate the conditions when this defect occurs: 

1. Go to Control Panel > Setup > Venues.

2. From the Main Menu window, go to the Management Dashboard. Select Tools > SV Director 
Configuration > System Configuration > StadiumVision Remote.
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3. Modify the value for the JMX Password.

4. Switch to the browser window that has the Control Panel Venues panel open from Step 1.

5. Create a new venue with the default pre-populated values for Password.

Workaround Reload the Venues panel, if it is already open, after you change the venue JMX credentials 
in the Management Dashboard registry. 

Related Documentation
For more information about Cisco StadiumVision hardware and software installation, configuration, and 
operation, see the Cisco StadiumVision documentation available on Cisco.com at: 
http://www.cisco.com/en/US/products/ps11274/tsd_products_support_series_home.html

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.

This document is to be used in conjunction with the documents listed in the “Related Documentation” section.

Google, Google Play, Android and certain other marks are trademarks of Google Inc.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any 
examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. 
Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

© 2013–2014 Cisco Systems, Inc. All rights reserved.
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